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TOPIC -----------------------------------------------------------

This Article Is The About Desktop Printing Document With System 7.5, Version
7.5.3.

DISCUSSION ------------------------------------------------------

About Desktop Printing

Your New Software Comes With Desktop PrintMonitor Version 1.0.3. You Use Desktop
PrintMonitor To Create Printer Icons (or "desktop Printers") On Your Macintosh
Operating System (Mac OS) Desktop. You Can Print A Document By Simply Dragging
It To A Desktop Printer Icon. Desktop Printers Also Give You More Control Over
Printing, Including Setting Printing Priorities And Choosing Specific Times For
Printing.

Creating Desktop Printers
-------------------------
You Create Desktop Printers By Selecting A Printer In The Chooser. A Desktop
Printer Icon Appears On Your Desktop When You Close The Chooser.

You Can Drag This Icon To Any Position You Want On Your Desktop. You Cannot Move
It Off The Desktop.
If You Want, You Can Select Other Printers In The Chooser And Create Other
Desktop Printers For Easy Access. You Must Close The Chooser Each Time To Create
A Desktop Printer.

The Last Desktop Printer Created Becomes The Default Printer. Your Documents
Will Automatically Be Printed On The Default Printer.

Printing With Desktop Printers
------------------------------
You Can Print Documents Within Your Applications As You Normally Do. You Can
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Also Print Documents Without Leaving The Finder, Using One Of The Two Methods
Described Here. These Methods Are Particularly Efficient When You Have A Number
Of Documents You Want To Print At Once.

• Drag The Icons Of The Documents You Want To Print To The Desktop Icon Of
  The Printer You Want To Use.
• Select The Icons Of The Documents You Want To Print And Choose The Print
  Command From The File Menu.

The Computer Will Show You The Print Dialog Box So You Can Choose Printing
Options. Make Your Choices, Then Click The Print Button.

After A Few Moments, The Document Starts To Print. If Background Printing Is
Turned On, You Can Continue Working While The Document Is Printing.

Selecting A Default Printer
--------------------------
If You Have More Than One Printer Available, You Can Select Which You Want To
Use. The Printer You Select Is Called The "default Printer." All Your Documents
Will Be Printed On The Default Printer Until You Select A New One.

To Change The Default Printer, Use One Of These Three Methods:

• Drag The Document You Want To Print To A Desktop Printer Icon, And It
  Will Automatically Become The Default Printer.
• Select The Desktop Printer Icon And Use The Printing Menu To Set The
  Printer As The Default.
• Select A New Printer Using The Chooser.

NOTE: Switching Between Printers May Change How Much Information You Can Fit On
A Page. It's Best To Choose A Printer Before You Spend Much Time Formatting The
Document.

Working With Desktop Printer Icons
----------------------------------
Desktop Printer Icons Change To Indicate Printing Status:

- Plain icon indicates a printer that is not currently chosen for
  printing.
- Default icon indicates the printer you have currently chosen to print
  on.
- Printing icon indicates a document is printing on this printer.
- Stopped icon indicates you have stopped the print queue.
- Error icon indicates there is an error on this printer. double-click the
  icon to see a message.
- Disabled icon indicates this desktop printer is not available.

You Can Do The Following With Desktop Printer Icons:

• Throw Away The Icon. Drag The Icon To The Trash. You Can't Throw Away A
Desktop Printer Icon While The Printer Is Printing A Document. (You Can Create
Another Desktop Printer Icon For That Printer Whenever You Like.)
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Note: You Must Always Have At Least One Printer Icon On Your Desktop. If You
Throw Away The Last Icon, It Will Immediately Be Created Again.

• Rename The Icon. Rename The Icon As You Would Any Other Finder Icon. Click The
Name To Highlight It, Then Type The New Name. This Changes The Name Of The Icon,
Not The Name Of The Printer.

• Move The Icon. You May Drag The Icon Anywhere You Like On The Desktop.
However, You May Not Move It Off The Desktop.

• Create An Alias For The Icon. You May Create An Alias For The Icon As You
Would Any Finder Icon, By Selecting The Icon And Choosing The Make Alias Command
From The File Menu. The Alias May Be Moved Anywhere On Or Off The Desktop.

Monitoring Printing
-------------------
If You Are Using Background Printing, You Can Use The Desktop Printer Features
To Monitor And Control The Documents That Are Waiting To Print. To Learn How To
Turn Background Printing On And Off, See Your Printer Manual.

To Monitor The Printing Of Documents:

1) Double-click The Desktop Printer Icon You're Interested In.

A Window Opens Listing The Documents That Are Printing Or Waiting To Print.

Watching The Status Messages Can Be Helpful When Troubleshooting Printing
Problems. When More Than One Job Is Waiting To Be Printed, A List Of Print Jobs
Appears In The Waiting List, Showing The Order In Which They Will Be Printed
(when Sorted By Print Time.)

2) Choose What You'd Like To Do.

• To Cancel A Print Request, Select It By Clicking Its Icon And Click The Remove
Button.

You Can Only Select The Currently Printing Document By Clicking Its Icon. (You
Can Select More Than One Item At A Time By Holding Down The Shift Key While
Clicking.) You Can Also Drag The Icon For The Print Request To The Trash. Note
That These Methods Delete Only The Print Request (also Referred To As A Spool
File), Not The Document Itself.

• To Put A Print Request On Hold, Select It And Click The Hold Button.

The Print Request Will Stay On Hold Until You Select It Again And Click The
Resume Button. You Can Also Put The Document That's Currently Printing On Hold
By Dragging It To The List Of Documents Waiting To Print (lower Part Of The
Window).

• To Indicate That A Print Request Is Urgent, Select It And Choose Set Print
Time From The Printing Menu. In The Dialog Box That Opens, Click Urgent.

• To Indicate That A Print Request Should Not Print Until A Future Time, Select

..TIL20091-System_7-5_Version_7-5-3-About_Desktop_Printing_6-96_(TA35737).pdf



It And Choose Set Print Time From The Printing Menu. In The Dialog Box That
Opens, Click At Time, Then Set The Time You Want.

• To Change The Order Of The Items Waiting To Print, Move Their Place In The
List By Dragging Their Titles Up Or Down In The List.

• To Sort The List Of Documents Waiting To Print, Click The Title Of The Column
You Want To Sort By.

For Example, To Sort By The Name Of The Document, Click "Document Name." (You
Can Also Sort By Choosing The Commands In The View Menu.) The Column Title You
Sorted By Is Underlined. Sorting The Items Does Not Change The Order In Which
They Will Print. To See That Order, Sort By Print Time.

• To Temporarily Stop All Documents From Printing On This Printer, Choose Stop
Print Queue From The Printing Menu.

To Resume Using The Printer, Choose Start Print Queue From The Printing Menu. If
The Desktop PrintMonitor Window Is Open, You Can Begin Printing The Document
From The First Page By Option-clicking The Resume Button (holding Down The
Option Key While Clicking The Resume Button).

Shortcut: The Printing Menu For Starting And Stopping The Print Queue Is
Available Without Opening The Window For The Printer, As Long As The Printer's
Icon Is Selected On The Desktop.

• To Move A Print Request From One Printer To Another Printer Of The Same Type
(for Example, From A LaserWriter 4/600 PS To A LaserWriter 16/600 PS), Drag The
Icon For The Print Request To The Icon Of The Printer Where You Want To Move
It.

You Can Only Move A Print Request From A PostScript Printer To Another
PostScript Printer. The Printing Software Won't Let You Move A Print Request To
An Incompatible Printer. For Example, You Can't Move A Request From A
LaserWriter Printer To A StyleWriter Printer.

Turning The Manual Feed Notification On Or Off
----------------------------------------------
The Desktop PrintMonitor Is Set Up To Notify You About Manually Feeding Paper
The Same Way Your PrintMonitor Was Set. For Example, If You Turned Off
Notification For Manual Feeding In Your PrintMonitor, The Desktop PrintMonitor
Will Also Have Manual Feed Notification Turned Off.

If You Want To Change How The Desktop PrintMonitor Notifies You About Manual
Feeding, Follow This Procedure:

1) Hold Down The Shift Key And Restart Your Computer, Keeping The Shift Key
Depressed Until The Message "Extensions Off" Or Your Normal Desktop Appears.

2) Open Your System Folder And Then Open Your Extensions Folder.

3) Double-click The PrintMonitor Application.
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4) Choose Preferences From The File Menu.

5) Select Your Manual Feed Option And Click OK.

6) Close The PrintMonitor.

7) Restart Your Computer.

Turning Off Or Removing The Desktop Printing Software
-----------------------------------------------------
Removing A Desktop Printer Icon

You Can Remove An Individual Desktop Printer Icon By Dragging It To The Trash.
If You Have Only One Desktop Printer, You Can't Get Rid Of The Icon By Dragging
It To The Trash. (The Icon Will Reappear If You Do.) To Get Rid Of The Desktop
Printer, You Must First Select A Different Desktop Printer As The Default
Printer And Then Drag The Desktop Printer Icon To The Trash. If You Don't Want
To Use Desktop Printer Icons, See "Turning Off The Desktop PrintMonitor" Or
"Removing Desktop Printing Software" For Information About How To Remove The
Desktop Printer Software.

Turning Off The Desktop PrintMonitor

If You Don't Want To Use Desktop Printers, You Can Turn Off The Desktop
PrintMonitor Using The Extensions Manager (available On Macintosh System 7.5,
The Current Version Of The Mac OS).

To Turn Off The Desktop PrintMonitor:

1) Open The Extensions Manager Control Panel In The Control Panels Folder.

2) Click To Deselect (uncheck) The Desktop PrintMonitor, Desktop Printer
Extension, And Desktop Printer Spooler Extensions In The Panel.

3) Click The Close Box To Close The Control Panel.

4) Restart Your Computer.

Removing The Desktop Printing Software

The Desktop Printing Software Uses Both The Desktop PrintMonitor And The
PrintMonitor Software. The Desktop PrintMonitor Requires 200-400K Bytes More
Free System Memory In Addition To The Memory Required By The PrintMonitor. If
You Don't Want To Use The Desktop Printing Software, You Can Remove It.

To Remove Desktop Printing Software:

1) Restart Your Computer With The Extensions Off By Holding Down The Shift Key
And Choosing Restart From The Special Menu. Hold The Shift Key Down Until The
Message "Extensions Off" Appears Or Until Your Normal Desktop Appears.

2) Drag The Following Files From The Extensions Folder To The Trash:
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   Desktop PrintMonitor 1.0.3
   Desktop Printer Spooler 1.0.3
   Desktop Printer Extension 1.0.3

3) Restart Your Computer.

Using Save Or Open With Desktop Printers
----------------------------------------
When You Choose Save Or Open In Your Application Programs, You Will See Your
Desktop Printers Listed As If They Were Folders, But You Should Not Save Or Open
Any Documents In Them. If You Do, You Will Not Be Able To Access Your
Documents.

Having More Than Five Desktop Printers
--------------------------------------
If You Want To Have More Than Five Or Six Desktop Printers, You Must Increase
The Desktop PrintMonitor Memory Allocation By 12K For Each Additional Desktop
Printer You Want. To Do So, Select Its Icon (it's In The Extensions Folder
Inside The System Folder), Choose Get Info, Type A Larger Number In The
Preferred Size Box, Then Close The Get Info Window.

About Creating Duplicate Desktop Printer Icons
----------------------------------------------
If You Use Different Versions Of The LaserWriter 8 Software And Print Using The
Desktop PrintMonitor, You May Create Duplicate Desktop Printer Icons For The
Same Printer. For Example, Say You Use The LaserWriter 8.3 Driver For Printing
And Also Use The LaserWriter 8.2.2f Driver For Faxing. If You Select Your
Printer In The Chooser Using The LaserWriter 8.3 Driver, And Select It Later
Using The LaserWriter 8.2.2f Driver, Two Desktop Printer Icons Will Appear For
That Printer. To Avoid Creating Confusing Duplicate Printer Icons, Primarily Use
One Version Of Your Printer Software Driver, Or Rename The Icons With
Distinguishing Names.
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